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Please read all of this document - it's important! Really!
We’ve tried to make this readme file informative, useful and fun. You might even find a clue to any
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Reading this Document
Using Write
To make this document easier to read, enlarge the Write window by clicking the Maximize button 
in the upper-right corner of the window. Or open the Control menu in the upper-left corner of the 
Write window (press ALT+SPACEBAR), and choose the Maximize command.

Make sure that you are in Portrait Orientation. To check, open the File menu and select Print 
Setup.... Click the Portrait button if it’s not set.

Use the Find menu to search for information which may be of interest to you. Readme files are 
the last chance for producers, programmers, managers, play testers and other nefarious types to 
include important information. As such, information can be a little “scattered”. Search (with Find) 
and you may be pleasantly surprised. It ain’t hyper-linked text, but it’s the next best thing.

To move through the document, press PAGE UP or PAGE DOWN. Or click the arrows at the top 
and bottom of the scroll bar along the right side of the Write window.

To print the document, choose Print... from the File menu. 

For Help on using Write, press F1.

NOTE: The screen shots in this Readme file are in 16 color BMP files to keep this file as 
small as possible. Also, the screen shots may not look all that spiffy when printed. Believe 
me when I tell you that the game looks much better in 256 colors. 
Using Something Other Than Write
This document has been written using an outline structure. Unfortunately, Write doesn’t support 
an outline structure.

If you can load this document into another word processor that CAN display it in an outline, you’ll 
be able to find help and information more quickly by reading subject headings.

Actual Read Me information starts here...

Technical Stuff
Introduction
Games are pushing the envelope of software development. Word processors and spreadsheets, 
for all their menus and functions and what not, mostly just sit in memory and wait for you to do 
something. Games are running all the time, grabbing resources and forcing video drivers to 
perform at peak level. SimTower may be “just a game”, but it’s a busy game, and it’s making your 
system work all the time... even when the window is minimized.



If you're having trouble running SimTower for Windows, or are getting error messages, check out 
this section first (it’s why we put it near the top of the file).  These tips were compiled and written 
by the Virtual Adept Magi of Maxis Customer Support and QA., and contain enough information to
make you an expert too (or at least enough to make you sound like one).

Installation Problems

NOTE: If you are using memory managers (such as QEMM) other than the standard 
utilities that come with DOS, these installation instructions do not apply.

If the SimTower installer reports a General Protection Fault (GPF), AND you’re running DOS 6.0 
or higher, follow these steps (you earlier version of DOS users should skip to the next section):

1. Reboot your computer. Either press the reset button on your computer's case OR press 
Ctrl+Alt+Delete on your keyboard all at the same time to reboot.
2. Watch the boot-up process closely for the Message "Starting MS-DOS...".
When you see this message press your "F8" key once. You'll have to be nimble, since the 
"Starting MS-DOS..." message only gives you 2 seconds. If you succeed, you’ll see a message 
that says "DOS will prompt you to confirm each line of the CONFIG.SYS and 
AUTOEXEC.BAT files."
3. The order in which the lines are presented to you depends on your machine. Answer "Y" to the
following lines in the CONFIG.SYS file:
DOS=HIGH,UMB (These items may be listed on separate lines 'DOS=HIGH' and 'DOS=UMB'.)
DEVICE=C:\DOS\HIMEM.SYS (This line may be listed as DEVICE=C:\WINDOWS\HIMEM.SYS)
NOTE: There are NO SPACES used in these lines!
4. Answer “N” to ANY other lines. This means ANY other lines.
5. You’ll be deposited at the (dreaded) C:\> prompt. Don’t be scared. Just type in "CD\
WINDOWS" then hit [Enter].
6. You will now be in the Windows directory. Your prompt will read, "C:\WINDOWS>"
7. Type "WIN" [enter] to start Windows. Windows may be a little slower than usual.
8. Now follow the setup instructions in the SimTower Addendum & Quick Start Guide.
9. After installation, reboot your computer and let it start up as usual.
10. If you still receive GPFs contact Maxis Customer Support.

The Next Section (for pre DOS 6 users)
You’ll likely need to create a boot disk to prevent conflicting software from loading. This boot disk 
MUST be in Drive A. DOS looks in Drive A for booting instructions before it looks in Drive C. It 
NEVER looks in Drive B. If you only have one floppy drive, DOS always looks in that drive before 
it looks in Drive C.

Making your boot disk
First, read these instructions once (or perhaps twice) to familiarize yourself with the procedure 
and what you’ll need. 



Here’s what you do to make a boot disk:
1. Place a blank, formatted disk in the A: drive.  (If your floppy disk is not formatted, put the disk in
the “A:” drive and then from the “C:\>“ prompt type in “format a:” then press <Enter>.
2. Get to your C: prompt by typing “C:” <Enter>
3. Type “SYS A:” <Enter> (This puts basic system files on the floppy in your A: drive.)
4. Type in “A:\” <Enter> to switch to your “A:” drive.
5. Make sure that you are on the “A:” drive; if you are not, BAD things may happen.
6. Create a CONFIG.SYS file by following these instructions:

a. Type “copy con config.sys” <Enter>
b. Type “DOS=HIGH,UMB” <Enter> (no spaces)
c. Type “device=himem.sys” <Enter> (no spaces
d. Press the F6 key (you will see “^Z”), then press <Enter>.  You’ll get a 

message telling you that one file has been copied.

Reboot your machine with this boot disk in drive A. This will let you bypass your auto-loading stuff
and give control back to you. You’ll end up at the C:>prompt. Type “cd\windows” <Enter>. Now 
you’re at your Windows directory. Type “win” <Enter>. This loads Windows.

System Conflicts

Conflicts are rare but they can occur. If you’re not having problems, take no action (or, if it ain’t 
broke, don’t fix it).

If you are having problems (or if the fine writing in this file seems interesting), read on.

Many people make Windows load some programs automatically. Some of these programs are 
benign. Others are resource hogs. The easiest solution is the most drastic: turn off everything but 
the Program Manager and SimTower to free memory and system resources.

If that’s a bit much, consider that most problems are caused by two types of programs. The worst 
offenders are screen savers. If you’re using a screen saver (even the default Windows screen 
saver), you should disable it to prevent conflicts when running SimTower.

The second worst offenders are virus protection programs. It’s a sad comment on our times that 
virus protection programs are a necessity, but really, the only time they actually do any good is 
when a disk is inserted. There’s no reason to have them running if all you're doing is building a 
tower. If you experience trouble running SimTower for Windows, try disabling virus protection 
programs. 

To determine if something else is running, hold down the <Ctrl> key on your keyboard then press 
the <Esc> key at the same time. This brings up the Windows Task List.

Ideally, the only item in the Task List window should be Program Manager. If there are any other
items shown, and you want to disable them, click on the item to highlight it and click on the End 
Task button to turn it off. Repeat until only Program Manager is active. Now run SimTower for 
Windows.

Some Other Things To Consider

Windows Shells other than Program Manager
Shell programs are third party replacement programs that you can use in place of the standard 
Windows Program Manager. These include such things as HP Dashboard, the Norton Desktop, 
and XSoft's TabWorks (which comes installed on most Compaq computers).



If you are having trouble installing or running SimTower for Windows, try either turning off the 
shell you are using, or using that program's File - Run command to run Program Manager. The 
command line to run Program Manager is C:\WINDOWS\PROGMAN.EXE. Once you have 
installed SimTower, you should be able to close Program Manager and run SimTower through the
shell program you usually run.

Some shell programs simply won't let you run SimTower properly. If you have successfully 
installed SimTower but it still won't run, try turning off the shell program you have been using.

A Special Note About TabWorks: If you are running TabWorks, we STRONGLY recommend the 
following procedure to eliminate extraneous icon creation and other bizarre problems.
1. Go to the Options menu.
2. Select File Tracking Options, and deselect Track File Creation and Track File Modification.
This will allow you to install SimTower through TabWorks without having to run Program Manager.

QEMM, 386MAX, and other "cloaking" or "shadowing" memory managers.
QEMM has a feature called "Full Stealth Mode". Full Stealth Mode tries to free as much lower 
memory as possible by "cloaking" or "shadowing" all the devices and drivers in upper memory. 
This would include most the BIOS on most video cards. Unfortunately, neither SimTower nor 
WinG (the Windows Graphic utility that SimTower uses) will detect your video BIOS if it’s cloaked 
or shadowed. We recommend that you turn off Stealth Mode altogether or do not include the 
Video Regions in the optimization of your system. If you need any assistance with these 
procedures PLEASE call the manufacturer of your memory manager to confirm that what you are 
using is WinG compatible.

Increase Resources
If you get occasional General Protection Faults in MMTASK or MCISEQ, try increasing the buffers
allocated for sounds. To do this, open the Control Panel icon and select Drivers. In the Drivers 
window, there will be a list of items like "Timer" and "[MCI] Sound". Highlight "[MCI] Sound", and
click on the Setup button. Usually, the MCI Waveform Driver Setup window will be configured 
for a 4 second buffer. You should try increasing that to 6 seconds.

Be Bold!
When all else fails, increase the amount of low memory available in DOS. See your DOS manual 
for information on increasing the amount of memory available.

Sound and Music

SimTower for Windows supports all sound cards that are compatible with Windows 3.1. If you do 
not have a sound card, you will get a message reminding you of this. Click Continue. SimTower 
will run without sound.

If you have a sound card, check the Options menu in SimTower. In the Options menu is an item 
called Sound, which has three selections: Elevators, Background, and Events. For sound to 
play, at least one of these menu items must be selected. Having all three selected gives you the 
full range of sounds in a building. Turning off all three gives you more speed from your computer.

There is no music in SimTower.

Video, palettes and pictures



The Most Important Video Information In This File
Some video drivers shipped with Windows 3.1 do NOT work on most systems. These drivers are 
designed to work only with specific video cards. Chances are that you do NOT have this type of 
card! These are the drivers which begin with Video 7 or XGA.

If you use these drivers but don’t have the cards they are designed for, you’ll get a blank screen 
when Windows loads. Windows is actually running just fine, but it’s kind of hard to use a graphic 
interface if you can't see the graphics.

If you are reading this after you have already loaded one of these drivers and you no longer can 
load up Windows, call your video card manufacturer. In a few paragraphs you’ll find out how to
change your Windows driver back to VGA. If you have any doubts about changing your display 
drivers around, PLEASE call your video card manufacturer.

What are Video Drivers?
Windows uses programs called Video Drivers to control how your particular graphics card 
displays things on the screen. Usually, the video card installed in your computer has a set of 
video drivers for you to use with Windows. Windows itself comes with video drivers that work on 
almost any video card and allow your computer to display 16 colors with a resolution of 640x480 
pixels.

What Does This Have to Do with SimTower?
Many people have only the generic 16 color video drivers installed. Others have video drivers 
which allow more than 256 colors. What’s a poor company to do?

Well, what we did is allow SimTower to run in color resolutions other than 256. Obviously, 
displaying 256 color artwork in only 16 colors can produce some effects which are... less  than 
artistic.

On the other hand, some of the animation or colors in SimTower may not work properly with 
systems running in more than 256 colors.

In both the above cases, SimTower is still playable, so if you don't have 256 color drivers or are 
not sure how to install them, you can still play SimTower.

However, for absolutely the most bestest results, we recommend that you run SimTower in 256 
colors. Your video card manufacturer or documentation should have information to help you set 
your card for 256 colors.

The steps to change your video driver are system-specific; you may have an icon in your Control 
Panel or perhaps a separate group for setting and changing resolutions and the number of colors.

We recommend that you check with your vendor or manufacturer for information on your display 
card, but here are some general hints and tips we can run through.

General note on video cards 
WinG (the graphic utility that SimTower uses) will usually warn you if your drivers are 
incompatible. If you do not get the warning, most likely you will not have video trouble.

This does not mean that the WinG check is 100% correct so if you have video trouble consult 
your video card manufacturer to check the WinG compatibility of your video card.

If you do not know what company makes your video card, consult the manufacturer of your 



computer to find out what brand of video cards they have been using on your model machine.

Changing Your Video Driver
WARNING: Follow these instructions ONLY if you and your computer are on friendly, 
familiar terms.
You may need your original Windows disks (they have programs which you might need but which 
may not have been installed) so it’s helpful to have them handy.

Next, find the Windows Setup icon and double-click it to open it. It’s usually in the Main program 
group. Display shows you what your system is set for. If it's just "VGA", that means 640x480 
resolution with 16 colors. We’re going to change that to something a little nicer.

Open the Options menu and choose Change System Settings. Click the down arrow at the 
right side of the Display bar to show a list of drivers that are in the options. Scroll up and down to 
see the available selections. Look for one that lists specifically 256 colors. (Remember, you most 
likely do not want the Video 7 or XGA drivers!)  When you find one, select that setting by clicking
on it, then click on OK.

If you don’t find a driver for your card, you can still use Other display at the end of the list. In this
case, you’ll definitely have to tell the Settings program where your driver is, since it already can’t 
find it.

Most likely, what you want is installed already. If so, you’ll get a prompt asking you if you want to 
use the currently installed driver or use a new one. Most of the time you’ll want to use the 
currently installed driver (unless you have a newer version of what’s installed). If it’s not installed, 
you’ve got your Windows disks handy. Insert any disks as requested.

Click the Restart Windows button when instructed.

It Don’t Work. Now What?
It is possible that after Windows restarts with the new driver that your display will blank out or not 
function properly. This indicates, at the very least, that you have loaded the wrong driver for your 
video card. It may also mean that you will need a specific driver for your card.

Don’t panic. Here’s how to put things back the way they were.
1. Get to your C:\> prompt.

If your computer goes straight into Windows without you typing anything, 
you must prevent that from happening. If you have DOS 6.0 or higher, you can press the F5 key 
when you see the prompt “Starting MS-DOS.” If you have an earlier version of DOS, you must 
use a boot disk to boot from your A: drive.
2. Get to the Windows directory (type CD\WINDOWS [Enter]).
3. At the C:\WINDOWS> prompt, type SETUP [Enter]). This loads the DOS version of the setup 
program you used to change your video driver.
4. Use the keyboard arrow keys to move to the DISPLAY line and hit [Enter].
5. Now you can use your arrow keys to scroll the listed options to VGA. Hit [Enter]
6. Use the arrow keys to go back down to Accept these settings...
Load windows like you normally would. 
Specialized Video Stuff
Diamond Stealth 64 DRAM/VRAM
If you have a Diamond Stealth 64 DRAM or VRAM video card, you should disable all "Power 
Saver" features (even the DOS ones)! Otherwise, your system can actually turn off while 
SimTower is in the foreground. We’re not sure why this happens, which makes it very difficult to 
fix.



Cirrus Logic Chipset
Certain older drivers shipped with Cirrus Logic video cards may be incompatible with SimTower 
for Windows. Make sure you have the most recent versions of the video driver for your card
or use the Microsoft Generic SVGA drivers, available on most on-line systems or from 
Microsoft.
Windows for Workgroups 3.11
If you have Windows for Workgroups 3.11, you should look at the options for "SuperVGA". Make 
sure to select one that lists 256 colors. "SuperVGA (640x480, 256 colors)" or "SuperVGA 
(800x600, 256 colors)" should be good choices. These are generic Microsoft drivers that work 
with many cards. These Microsoft generic drivers are available through many shareware dealers 
or from Microsoft. Even though they aren't optimized for your card specifically, they should get 
you going. If you have problems with them, we recommend that you get a driver that is specific to 
your card. Usually, you can get such a driver from your dealer or the card's manufacturer.

You may also see a message from the Windows Graphics package, WinG. It runs a calibration 
test the first time it installs to optimize video performance. It may warn you that it is using a slower
method of video due to "an older version" of your video card software; SimTower and WinG will 
run for now, but we would recommend obtaining an updated version of your display driver (one 
that is WinG-friendly) at your first convenience, from the dealer or manufacturer of your video 
card. It is a good rule of thumb to keep your video and sound drivers updated with the best 
version available from the manufacturer.

Memory Issues
The General Idea
SimTower for Windows requires that you run Windows in 386 Enhanced Mode (Microsoft calls it 
that whether you've got a 386, 486 or a Pentium).
You can check to see if you are in Enhanced Mode by choosing Help in your Program Manager, 
then going to About Program Manager...

If About Program Manager says you are in Standard Mode, exit Windows, then restart with the 
command WIN/3 <Enter> instead of WIN. This will force Windows to start in Enhanced Mode.
If you cannot run Windows in Enhanced Mode, please verify that your system meets or exceeds 
the minimum system requirements printed on the system requirements label on the box your copy
of SimTower for Windows came in.
Windows for Workgroups 3.11
If you're using Windows for Workgroups 3.11, the only possible mode is Enhanced, so the 
About... box won't mention mode, just free memory. This is normal and cool.

Using Virtual Memory
Disk Compression Users
If you’re using disk compression software such as DoubleSpace, DriveSpace, Stacker, SuperStor
or things like that, these instructions ARE NOT for you. Most of these programs will come with 
their own utilities to use virtual memory. Refer to the documentation that came with your 
compression program for more information).
Non Disk Compression Users
If you don't have enough memory to run SimTower for Windows, first close all other programs that
are running to free up the necessary memory.

If this doesn't correct the problem, there’s still hope. To prepare yourself, you might refer to the 
Windows manual section called MEMORY. There are several different options explained in the 
manual, from editing your startup configuration files to using Virtual Memory. We can help you out
a little here (and we’re somewhat less daunting than the Windows manual).

Virtual Memory uses your system's hard disk drive to temporarily store information that would 



normally be kept in the system RAM memory. It’s a little slower than RAM, but you have the 
potential to increase your available memory quite significantly.

You run Virtual Memory by following these steps:

1. Find your Control Panel icon. It’s usually within the Main program group.

2. Double-click on the Control Panel icon to open it.

3. Double-click on the Enhanced icon (the icon looks like a computer chip -- if it is not there, you 
are not running Windows in Enhanced Mode. See the instructions on starting Windows in 
Enhanced Mode.)
4. Click on the Virtual Memory... button to open the Virtual Memory window.
5. Click on the Change button. You’ll get a window which has some important information. The 
most important information is the Recommended Maximum Size for Virtual Memory on your 
computer. This number will vary from machine to machine. If your computer is not already set to 
this number, you’re in luck. Type that number in the New Size box.
6. Check out your Windows manual for more information concerning virtual memory.

Finally, if you are using Sound Effects in SimTower for Windows, you will need as much free 
conventional memory as possible. Conventional memory is memory below 640k. Please see your
DOS manual for instructions on freeing conventional memory. If you have DOS 6 or higher, just 
run the MemMaker program. Type MEMMAKER <Enter> at your DOS prompt.

Gameplay Issues

Elevators

Q:  “My elevators never seem to be working right.  Everyone is stressed out and moving 
out of my tower.  Why aren’t they taking the elevator?  I just don’t understand this whole 
elevator thing."
A:  Get ready for a long winded, but informative, response.

If you prefer to develop your own strategy for success in SimTower you can skip over this.

Elevator control is one of the most important issues in SimTower. Elevators are the highways and 
byways that let your SimTenants move from floor to floor. Your tenants don’t like stairs much 
(even the tenants who work out). Take time to read the Elevators section on the SimTower.

What, you got more questions? Alrighty then, read on...

The primary key to successful transportation in SimTower is to section off your tower every 30 
levels. You’ll need the Express elevator (and three stars) to do this most efficiently, but you can 
fudge a little by having one (or two) “Standard” elevators skip floors 2-14 but stop on floors 1 and 
15-30 until you can build a real Express elevator.

When you are routing your elevators keep in mind that Sims will only transfer transportation 
modes ONCE.  This means if a Sim takes a Standard elevator from floor 35 to floor 30 then 
transfers to an Express elevator and continues down to floor 1 the Sim will not take anymore 
transportation modes other than walking.  If the Sim took an escalator to the Express elevator, 
that still counts as TWO modes of transportation. 

Sims look for the easiest way to travel from point A to point B.  They will usually take the closest 



elevator to their point of origin.  Here are the modes of transportation in the order that the Sims 
prefer to travel.  Escalators,  Stairs,  Standard Elevator,  Express Elevator.  Of course if the Sim is
on floor 15 she won’t be able to take escalators all the way down to floor 1.  But she will take the 
Standard elevator instead of the Express, even though they both travel to floor 1 from 15.

If you are getting demand messages from the Sims saying “Tenants on floor X cannot get to floor 
Y”. check to see if the Sims have adequate transportation.  If the transportation looks fine and you
still get the same demand, look closely at the lobby floor on which the Sim is changing 
transportation methods.  On the transfer lobby floor, make sure that there is actual lobby built all 
along the floor.  If there is any break in the lobby it will appear as a gray section on the floor.  Two 
sections of lobby with even a sliver of gray between them are NOT connected!  If a Sim tries to 
transfer on that floor and the elevator that they need to take is on the other side of the “break” in 
the lobby, the Sim will not be able to get to that mode of transportation.  This is what is causing 
the demand “Tenants on floor X cannot get to floor Y.”   

In really tall towers, some of your Express elevators should serve each 30-floor block exclusively 
(instead of every 15 floors). One (or more, depending upon the width of your tower) Express 
Elevator stopping at floor 15 is plenty. Also, if there are no facilities underground, there’s no 
reason to have an Express Elevator go there. 

When you are finally able to build Express Elevators, here’s a simple plan to follow: Start your 
first Express Elevator at floor 1 and raise it to floor 30. Start a Standard Elevator on floor 30 and 
raise it to floor 40. Add some cars to both new elevator shafts. Add the facilities of your choice. 
You really shouldn’t try to build up more than 10 more floors. Remember that you might not have 
a lot of money at this stage of the simulation. You can always add another elevator shaft and 
more facilities later. Below is a screen shot that will show you just what the heck we are talking 
about here.

The Elevator Control Panel
Open the Elevator Control Panel by clicking the elevator machinery with the “Query” tool. This 
panel can seem confusing at first, especially the “Floors Closer than Moving Cars.”

What Does It Mean: Floors Closer than Moving Cars?

The “Floors Closer than Moving Cars” setting determines how many elevator cars are moving in a
particular shaft at one time. The number in the “Floors closer than moving cars” box has a default 
setting of “5”. Here’s what that means:



Suppose a Sim is on the 20th floor and requests an elevator. At the same time, there is a empty 
car on the 26th floor not doing anything. With a setting of “5” the simulator looks 5 floors up the 
shaft (to floor 25) and 5 floors down the shaft (to floor 15) for any moving cars. If there’s a moving
car in this range, AND if it’s headed in the direction the Sim wants to travel, the moving car will 
respond to the request. The empty car on floor 26 would respond if there were no moving cars 
between floor 15 and floor 25.

If you change the number of “Floors closer than moving cars” to “1", all the elevator cars in a 
particular shaft will be moving most of the time. Moving all the cars all the time may not be a good
solution for your tower. Refer to your manual (especially the paragraphs on “waiting” or home 
floor locations for empty cars) to find out why.

What about the “Car Response Time?”

When Car Response Time is set to zero, it means that as soon as someone gets in the elevator, 
the doors close and the elevator leaves. If a lot of people are waiting for an elevator, it’s possible 
that only a few of them will be able to scamper in before the doors close.

You can reduce stress by letting your elevators wait for a while before taking off.

Below is a screen shot of the Elevator Control Panel. The settings in this screen shot are not the 
default settings! These settings will keep elevator traffic flowing well on MOST towers. If you have
especially heavy traffic on some floors you will need to find alternate routes for some of the Sims 
(e.g., escalators, stairs, or additional elevator shafts). Every tower you build will be a little 
different, and each will have unique transportation needs. Feel free to experiment and customize 
your elevator controls to suit your tower. The manual has a description of the buttons and 
functions of the Elevator Control Panel, as does the SimTower Help File.



Q:  Can I rename the different business sites in my tower, just like I can 
rename the people?"
A:  YES.  Even though there is no mention of this in the manual you can rename the 
any space you like.  Example:  "English Pub" can be named "Brian's Brewery".  Click 
the rename button and in the space that says "English Pub" type "Brian's Brewery".  
Then click on the rename button in the same window as the text field that contains 
"Brian's Brewery"  and you have successfully renamed a business site.  You can only 
have 15 characters in the new name.

Q:  "How can I tell where the V.I.P. is going to stay?"
A:  The V.I.P. will appear as a yellow Sim.  Contrary to the manual (page 58), the 
suite that the V.I.P. will stay in is not highlighted by a yellow box around it.  You can 
watch the V.I.P. go into their hotel room.

Q:  "Where is Housekeeping?"
A:  The Housekeeping button was moved from under the Security button (as page 20 
in the manual states) to under the Hotel room button on the tool bar.



Q:  "What are the requirements to get to the next star?"
A:  Star Rating Population

Event
1
You start SimTower with a 1 star Tower
2
300
None
3
1000
At least two security offices.
4
5000
More than one suite room.  Recycling and 

Medical demands satisfied.  A V.I.P. must 

visit and rate your tower favorably.
5
10,000
Metro station placed.  ALL demands 

satisfied. 
        Tower 15,000

Cathedral placed and wedding takes place. 

Q : "I am having trouble getting to my next star rating.  What’s up?"
A : On the higher star ratings SimTower only looks at your permanent population.  That means 
that your hotel tenants are no longer counted as population towards the next Tower level.  If you 
have plenty of permanent population, you might not have had the wedding take place in the 
cathedral.  The wedding will only take place on the weekend.  Also, try to place more of your 
tower’s service oriented facilities to improve your tenants evaluation of the conditions (Recycling 
centers, security, etc.).

Q:  "I'm a cheater and I want more money.  Are there any cheat codes in 
SimTower?"
A:  There is only one way to cheat in SimTower.  You must start a new tower.  Then 
before you place anything, place a section of lobby underground all the way down 
and to the left on the level below the "B9" level.  This will double your starting funds.



Q:  "Are there any limits to the number of facilities of a certain type you can 
place?"
A:  YES.  Some types of facilities have a limit on the amount you can place.  Here 
are the limits for a five star tower.
Cathedral =1
Elevator Shafts =24
Elevator cars per shaft =8
Fast Food + Restaurants + Retail Shops =512
Medical centers =10
Metro station =1
Parking spaces =512
Security offices =10
Stairs + Escalators =64
Cinemas + Party Halls =16

There is also a limit to the number of Sims you can name.  Only 20 Sims can have 
names at any one time.  

Q:  “The funds in the 'Finance' window do not match the funds in the “Status Bar”.  Is 
something wrong?"
A:  There is nothing wrong with your copy of SimTower.  The funds in the “Finance” window are 
rounded to the hundreds place, while the “Status Bar” will display all the way down to the ones 
place.  Example: if you have  $2000000 ($2 million) according to the “Status Bar” the amount will 
appear as $20000 in the “Finance” window.  SimTower’s prices are all in the thousands, and you 
are never going to have anything other “0” s in the last three decimal places of the “Status Bar” 
funds display.  (Which makes this a minor issue, but we are still sorry.)  If you add two “0” s to the 
amount in the “Finance” window it will exactly match the funds in the “Status Bar”. 

Q:  "The manual says that a Lobby section costs $5000, but every time I place a 
Lobby it charges me $22,000.  Why?"
A:  The "section" that the manual and SimTower text boxes refer to is different from
what the size of your cursor is when you select the Lobby tool.  A section as defined 
by the program as the smallest space that you can build with a tool.  The Lobby 
cursor is actually FOUR sections as defined by the program.  That will equal 
$20,000.  "Where does the extra $2000 come from?"  If you do not have the walls 
built (you can see the sky) on the floor where your going to place the lobby then you 
will be charged $500 for each section of floor you need to build.  Four sections equal 
$2000, and the grand total is $22,000.  
Note:  If you build a 2-story lobby on the ground floor (hold down the Ctrl key 
while you place the first section of lobby)  the total deduction from your funds will be 
$40,000 per cursor space.  If you build a  3-story lobby on the ground floor (hold 
down the CTRL and SHIFT keys while you place the first section of lobby) the total 
deduction from your funds will be $60,000 per cursor space.  

 



Q:  "How do I get rid of cockroaches once they have infested a room?"
A:  You must bulldoze the room.

Q:  "I want to move my Housekeeping space, but I can't seem to bulldoze it."
A:  Exactly; once you have placed Housekeeping you cannot bulldoze it.  Other 
spaces that can not be bulldozed are: Cathedral, Metro Station, Recycling centers, 
and Security offices.

Q:  "I have read the Help file, this Read Me file, and EVEN the Manual
all the way through, but I still have a question.  Who can help me?"
A:  You may now call Maxis Customer Support at 510-253-3755.  

Q:  How do I get a 2 or 3 story lobby?
A:  Oops. I guess we lied when we said there was only one cheat.

Talking to Real People
Customer Support
Give Customer Support a call if you have something really specific, like a graphic card problem or
an error message that no one (not even the System Analyst in your building) understands. You 
can reach them at 510-253-3755.

Before You Call Customer Support
The Most Important Stuff
Make sure you’ve read this Read Me file completely (we’ll know if you haven’t), in addition to any 
other appropriate material (like the manual). If you’re still at your wit’s end, there’s a few things 
you can do to make serving you and solving any problems a little easier.

The most important thing is to make sure that your computer system meets or exceeds the 
requirements defined on the SimTower system label. The system label is located in the lower-left 
portion of the front of the box.

The next most important thing is to call us from your computer! It’s much, MUCH easier to solve a
problem when you’re at your computer, and nearly impossible to solve when you aren’t at it.
The Next Most Important Stuff
It’s really handy to have a print-out of your WIN.INI, SYSTEM.INI, CONFIG.SYS and 
AUTOEXEC.BAT files. You can print these files by typing MSD <Enter> at the C:\ prompt. This 
runs the Microsoft Diagnostics program which will allow you to print out a report of your system. 
Remember, we don’t know what your system has, and we can’t see what it says on your screen.

If you can't print out your system files (for whatever reason), it’s not the end of the world, as long 
as you are at your computer when you call!

If you are getting error messages or General Protection Faults (GPFs), write down what the error 
message says. Include what you were doing when you got the message. This will help us 
diagnose the problem.



Write down all of the steps you have taken to try to solve the problem. If we know what you've 
already done, we may be able to get you running faster.

Have your program disks, your manual, and your Addendum available and within easy reach.

Ways to Get Ahold of Us
We aren’t trying to hide or anything. There’re lots of ways to contact Maxis.

The first is by telephone. If you decide that you would like to call and hear a friendly voice, you'll 
find the number and hours of operation for Customer Support listed on the Maxis Maxims sheet, 
included in the box your program came in. There is lots of other useful info there, so keep your 
Maxis Maxims somewhere handy.

By phone might not be handy for you. We are present on all of the major on-line services if you 
subscribe to any of them. If you don't currently subscribe, many on-line services will give you a 
30-day trial membership. Refer to the Maxis Maxims for more information on signing up. On AOL,
just e-mail to "Maxis", or use keyword "Maxis". On CompuServe, do "GO GAMBPUB" and leave a
message in the Maxis forum.

For you Internet users! We can be reached on the Internet via e-mailing to 
SUPPORT@MAXIS.COM; we have a microscopic ftp site at ftp.netcom.com in the /pub/ma/maxis
directory, which we are hoping to expand soon. World Wide Web site is 
ftp://ftp.netcom.com/pub/ma/maxis/http/maxis.html WHEW!! (Use a bookmark!!)

We maintain a BBS that is free-of-charge (although your phone company will hit you with long 
distance charges) to all registered users of Maxis products. The BBS number is (510) 254-3869 
and it is available 24 hours a day, 7 days a week. We support up to 14.4k BPS and have four 
nodes. The settings are 8-N-1. You can also find the latest FAQs (Frequently Asked Questions), 
hints and tips from other users and other good stuff.

Make sure you register your software! We've included a handy little postcard for you to send in. 
This will entitle you to FREE Technical Support for the life of the product. The product life ends 
when a new version is released or the product is discontinued.
Who we are
We’ve saved the best for the last, the names behind the faces behind the voices you’ll get when 
you call Customer Support. Be gentle with them. They didn't write the code or the manual, but 
they do provide support for the product which far outlasts jelly doughnuts (and other comestibles).

Roger Johnsen (Our Fearless Leader)
Aaron Shephard (Dr. Emu)
Brian Smith ()
Chris Charman (FAX-BACKS Guru)
Jeff Feil (AKA Quam)
Joy (Couldn’t do it without you) Carchidi
Kirk Lesser (AKA Blud - like the stuff in your veins. Don’t ask.)
Leo Kunkle (He's there for ya!)
Lisa Laverty (You have questions, Lisa has answers)
Owen Nelson (Owen Means Graphics)
Shannon Dawes (She makes great popcorn)
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